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Abstract 
This document details the release of software PSS0002-31. This is version 5.60 of software for the Mastersizer 2000 laser 
diffraction system. It covers software issues fixed and new features introduced. This information is required to perform a risk 
analysis to determine if the software should be installed. In this risk analysis the benefits of the new features provided and 
resolved software issues must be weighed against the risk of new issues that may be introduced to vital areas of the software 
or possible changes to the results of future analysis. Installation instructions are provided. 

 

Note: This software update only relates to the English and Japanese language versions of the Mastersizer 2000 
software. French, German and Chinese language options are only available for v5.12 of the Mastersizer 2000 software. 
The installation files for these versions are included on this software CD-ROM.  

Installation 
It is assumed that you have authority to install or update software within your facility. It is also assumed that you have 
Administrator rights for the system upon which the software is installed, as this is a requirement of the installation process. If 
you do not have this authority please consult with your I.T. support department before proceeding. 

Minimum System Requirements 
The key minimum requirements for running this software are highlighted in the table below:  

Feature Specification 

Memory 512MB, although it is recommended that at least 1024MB is 
available when using Windows XP and 2GB when using 
Windows Vista. 

Hard Disk Storage 80Gbyte 

Additional Storage Media CD-ROM drive 

Display Resolution 1024 x 768 

Connectivity 1 RS232 COM port 

Operating System Windows 7 Professional TM 
Windows Vista Business Edition TM with SP2 or high installed 

Windows XP Professional TM with SP3 or higher installed 
Windows 2000 Professional TM with SP4 or higher installed 

 

Although the software has been tested using Windows 2000TM, Windows Vista Business Edition TM, and Windows 7 
Professional, Windows XP Professional TM is still the preferred operating system. 

Software Update Notification 
PSS0002-31: Mastersizer 2000 v5.60 software 
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Instrument compatibility  
The Mastersizer 2000 v5.60 software is backwardly compatible with all prior versions of Mastersizer 2000. 

 

Note: In common with a large number of applications that undergo significant updating, data files produced by earlier 
versions will be compatible with this release but data files produced by this release may not be legible by earlier 
versions. Where there is regular correspondence between systems, users are advised to ensure that all instruments are 
updated to the same level. 

Installation Instructions 
The Mastersizer 2000 software is provided on one auto-loading CD-ROM. Inserting the CD-ROM into a system configured to 
auto-run a CD will run the installation program automatically. If your system does not support this feature run the 
\setupMS2K.exe program from the root directory of your CD drive. 

 

Note: In order to comply with the security requirements for the Windows TM operating systems, the directory structure 
used by the Mastersizer 2000 software has been changed. Please refer to the Known Issues section of this document 
in order to understand these changes prior to installing this software. 

 

Note: Some of the changes made to the control of the Mastersizer 2000 accessories require the accessory firmware to 
be updated when upgrading previous versions of the Mastersizer 2000 software.  

Please contact Malvern Instruments for information regarding how to upgrade the accessory firmware. 

 

Operating System Component Updates 
Mastersizer 2000 v5.12 for French, German and Chinese language systems can be installed on systems running Windows 
NT 4.0 TM. However, some of the Microsoft components required for the operation of the Mastersizer 2000 system may not be 
present within Windows NT TM operating system. This includes the Microsoft MDAC 2.5 components as well as Internet 
Explorer v4.1.  

The Mastersizer 2000 software installer will automatically detect if any operating system updates are required for these 
software versions. The required updates are included on a separate installation CD (PSS0018-01: Operating System 
Component Update Suite) for all the supported languages and are also available from the Microsoft Internet site for 
download. 

Uninstall Procedure 
The Mastersizer 2000 software can be uninstalled using the standard Add/Remove Programs feature in the Windows 
‘Control panel’. 

New Features 

21 CFR Part 11 Support 
Mastersizer 2000 v5.xx software includes full support for customers who require the software to run within a 21 CFR Part 11 
compliant environment. This includes new features relating to software access control, measurement auditing and the setting 
up of SOPs. These features are enabled by use of a software feature key which is specific to each instrument. Please contact 
your local Malvern Representative if you wish to obtain a feature key in order to enable the software’s 21 CFR Part 11 
features on your system. 
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Full details of the 21 CFR Part 11 features available within the Mastersizer 2000 software can be found in the following 
documents included on the Mastersizer 2000 software CD-ROM: 

• 21 CFR Part 11 User Guide (MRK1065-xx) – provides a full description of the software features associated with 
21CFR Part 11, including the software’s security system. 

• 21 CFR Part 11 Compliance Guide for the Mastersizer version 5.12 or later (MRK537-xx) – background 
information for users relating the functionality provided within the Mastersizer 2000 software to each of the 
requirements mentioned with 21CFR Part 11. 

Fixed Issues 
 

The following Software Change Requests (SCRs) have been implemented in version 5.60 of the Mastersizer 2000 software: 

 

SCR 
Number 

Description Type Comments 

6398 When the ‘ignore first measurement’ option is enabled in a dry 
measurement SOP, it is not applied consistently. 

Bug Fixed 

6769 If the application is launched by double clicking on a measurement 
file in Windows Explorer, the application crashes on exit.  

Bug Fixed 

7187 Russian characters do not display correctly. Bug Fixed 

7190 The instrument intermittently reports a CRC failure for the 
characterisation data. 

Bug Fixed 

7191 A "kernel FLASH CRC error" message is reported intermittently. Bug Fixed 

7266 The Audit Trail occasionally shows measurements created by an 
‘unknown’ user. 

Bug Fixed 

7267 The system occasionally locks-up when the live display is active. Bug Fixed 

7326 In remote mode, the background alarm should stop the SOP. Improvement Implemented 

7424 Problems within instrument control when using the Variflow options 
for the Hydro 2000G accessory. 

Bug Fixed 

7487 The advice links for the SOP pages do not seem to work. Bug Fixed 

7609 [CFB 00748] The code for ignoring the first result for dry powder 
measurements causes strange SOP values to be recorded. 

Bug Fixed 

7713 Some of the help buttons do not function correctly. Bug Fixed 
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SCR 
Number 

Description Type Comments 

8085 Dry accessory measurements do not terminate correctly. Bug Fixed 

8087 Negative values displayed in some particle size distribution report 
tables. 

Bug Fixed 

8088 The Mastersizer 2000 application does not start when a user double-
clicks on a measurement file. 

Bug Fixed 

8118 The dates displayed in report footer are not localised for foreign 
language systems. 

Bug Fixed 

8232 Instrument status can become corrupted, causing the ER/ES settings 
to be reset within the system registry. 

Bug Fixed 

8446 Edit->Copy parameter causes the application to crash. Bug Fixed 

8495 
Parameters with names longer than the boxes in which they are 
displayed can't be selected because of tool tips getting in the way. 
This applies when setting the Export or View select fields. 

Bug Fixed 

8705 Prevent stalling of the Autosampler 2000 additive and dispersant 
syringes (see known issues below). 

Improvement Implemented 

 

The software update notification documents relating to previous versions of the Mastersizer 2000 software are available from 
the support section of the Malvern Instruments website (www.malvern.com). Please refer to these documents for details of 
the new features released within each version of the Mastersizer 2000 software. 

Deletions 
No program features have been removed in this version of the Mastersizer 2000 software. 

Known Issues 
Autosampler 2000 Additive and Dispersant Syringe Operation 
It is possible for the Autosampler 2000 additive and dispersant syringe pumps to stall during operation, causing the 
Autosampler measurement schedule to halt. In order to overcome this, the firmware for the Autosampler 2000 has been 
updated to ensure that the syringes slowly accelerate to the required pump rate during operation. This has improved the 
robustness of operation of the Autosampler 2000 system. 

 

Note: All new Autosampler 2000 systems will be shipped with new firmware (v1.03). Customers wishing to update the 
firmware for existing Autosampler 2000 systems should contact their local Malvern Instruments service representative. 
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Loss of security settings 
It has been discovered that, when upgrading to Mastersizer 2000 v5.60 software from versions earlier than v5.54, it is 
possible for information relating to the security system set-up to be lost, including the user names and passwords for any 
users set up on the system. Users who have configured the security system to control access to the Mastersizer 2000 
software for different user groups are advised to read Malvern Instruments’ Technical Bulletin 1296, which provides a 
procedure for ensuring that the software can be upgraded without loss of the security system settings. This technical bulletin 
is included in the Documents section of the software CD-ROM. If you are in doubt about this procedure, please contact you 
local Malvern Representative for advice. 

 

New Directory Structure 
Since the launch of Windows 2000TM, the WindowsTM operating system has been set up to discourage the storage of data 
files into the Program Files group of folders. In order to avoid the security access problems associated with using the 
Program Files folders, this version of software has been set up to store data in the shared folders. The root Mastersizer 2000 
data directory will therefore be set to: 

• For Windows VistaTM: C:\ Users\ Public\ Public Documents\ Malvern Instruments \ Mastersizer 2000 
• For Windows XPTM: C:\ Documents and Settings\ All Users\ Shared Documents\ Malvern Instruments\ Mastersizer 2000 
• For Windows 2000TM: C:\ Documents and Settings\ All Users\ Documents\ Malvern Instruments \ Mastersizer 2000 

 

When updating an earlier software version, the software installation procedure will automatically move all of the user data 
from the previous root directory (C:\Program Files\ Malvern Instruments\ Mastersizer 2000) into the new directory structure.  

 

Note: It is recommended that users back-up their data prior to carrying out the installation process and should note both 
the old and new locations of the Mastersizer 2000 data files. 

 

Changes to SOP version control 
In previous software versions a mismatch could be observed between the SOP version number reported from the Compare 
SOPs dialogue and the version number reported on the records view. This inconsistency has been addressed in version 5.30 
and above of the Mastersizer 2000 software. However, the fix applied may cause the reported version number to change on 
result printouts. The observed behaviour will be: 

• If the SOP version shown in the Compare SOPs dialogue was the same as the SOP version number reported on the 
records view then no change will be observed. 

• If the SOP version shown in the Compare SOPs dialogue was lower than the SOP version number reported on the 
records view then the SOP version will be taken to be the higher value. 

As such, it is possible that some users will notice an increase in the SOP version number reported in the software. 

Scirocco Venturi Identification 
In version 5.30 and above, the ability to detect the type of venturi fitted to the Scirocco dry powder feeder has been provided. 
This requires the setting of one of the accessory identification switches (the A/B switch). As such, this feature will only work 
correctly for new Scirocco dry powder feeder units where the identification switch has been set according to the venturi type. 
For older Scirocco systems users should select the “Original Configuration” option in the SOP settings associated with the 
Scirocco in order to disable the auto-sensing feature. If users want to enable the ability to sense the venturi type for older 
Scirocco systems then please contact your local Malvern representative. 
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Upper Size Limits and Dv100 reporting  
 

Note: The use of the Dv100 as a control parameter is not advised, as this parameter is subject to large variations based 
on small changes in the dispersion and sampling regime. Malvern recommends that users use percentiles such as the 
Dv90 or Dv95 to provide control of the upper end of the size distribution. 

 
In previous software versions, some variability in the reported upper size limit for Mastersizer 2000 results was observed. 
This was caused by an incorrect tendency for the analysis to report an extremely small volume percentage of material 
(>0.0001%) at the limits of the analysis. This, coupled with the calculation method used for percentiles, caused the reported 
Dv100 to change considerably between measurements. 

In version 5.30 or above the analysis error associated with the reporting of small volumes of material at the analysis limits 
has been fixed and a new method for calculating the Dv100 has been implemented. These changes may affect the Dv100 
reported by the analysis, especially for those samples where the Dv100 value was always reported to be 2000μm. Testing 
has shown, however, that the shift in the reported values for percentiles below the Dv99.5 is negligible. 

File sizes 
In order to increase program performance, measurement records are kept in memory. For customers with a large number of 
measurements in a single file, this will affect the system performance by consuming large amounts of available memory. The 
best practice is to keep the number of measurement records in a single file to less than 1000, by creating new files on a 
regular basis. File access problems will be experienced within the Mastersizer 2000 application if the file size increases to 
greater than 2GB. 

Installing an earlier version after un-installing v3.x. or above 
To replace the Mastersizer 2000 application with another version, it is necessary to first uninstall the software using the 
command provided. When moving from version 3.x to version 2.00 or below, you must replace the Mastersizer 2000.ini file 
for the operation to succeed. Once the later software has been uninstalled, rename the Mastersizer 2000.ini file 
Mastersizer 2000.in3. Then install the earlier version. If this is not done, the old application will not run correctly.  

New security system 
The new security system introduced in v5.00 and higher is incompatible with the pre-existing ‘Secure Layered Access’ 
system. If v5.00 or higher is installed on a system with v4.00 or lower, the security settings will have to be reconfigured to add 
users and groups. 

Autosampler - flashing accessory icons 
The new version of the instrument firmware (FIDACS v1.03 or greater) must be downloaded to any instrument where an 
autosampler is to be used.  A full description of how to do this is included in the contents.txt file, stored in the root directory of 
the installation CD. 

Localised number formats 
The software does not function correctly if the number format set in the localisation settings of the system has the comma 
character either as the decimal marker of as the separator for thousands. The remedy is to modify the number format to 
exclude this character. This can be done in the Regional Options of Control Panel. 

Lactose Refractive Index 
The Lactose refractive index listed in the Mastersizer 2000 particle property database (1.347) is incorrect. The correct value 
for Lactose should be between 1.52 and 1.54. The entry has not been changed, as this could affect existing methods. If users 
wish to use the correct value, they are requested to set up a new entry in the software’s particle properties database. 
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Edit-Copy Parameter 
In Mastersizer 2000 version 5.60, a bug fix has been applied to ensure the Edit->Copy function associated with report views 
does not cause the software to crash. Users should note that this menu option will only copy the first parameter added to the 
report during report creation. If the copying of multiple parameters is required, users are advised to set up an export template 
containing the desired parameter set. The File->Export Data command, available when the Records view is active, can then 
be used to export the parameters to the Windows clipboard. Alternately, if the export template is set as the default template, 
the Edit-Copy menu option can be used to transfer the parameters to the clipboard. 

Accessing Measurement Files via Windows Explorer 
In the past, it has been possible to open a Mastersizer 2000 measurement file by double-clicking on the file from within 
Windows Explorer. This caused the Mastersizer 2000 software to start with the selected file opened. The operating system 
mechanism required to enable this to occur (Dynamic data exchange) has been removed from Windows VISTA. For this 
reason, this mechanism for opening files has been disabled in v5.60 of the software. Double clicking on a Mastersizer 2000 
measurement file will cause the software to start, but users will have to browse for the file using the File->Open menu option 
within the software. 

If you are using Windows XP, a mechanism does exist for re-enabling the ability to open files from within Windows Explorer. 
Please contact your Malvern Representative for a technical note describing how this can be done. 

Overlay cumulative colour problem 
The frequency and undersize/oversize plot should be the same colour so you can see which plots belong to which record. 
The 4th undersize/oversize plot has different colours for these curves making it harder to figure out which plot belongs to 
which curve. 

SOP Parameter Reporting 
For computer systems operating in time zones which are set at half-hour increments from GMT (e.g. Mumbai, India at GMT 
+5:30hrs, Adelaide Australia at GMT +9:30hrs), a bug has been discovered relating to the way some time-based parameters 
are displayed within the SOP editor dialogues. For parameters such as the Pre-measurement delay and Obscuration Filter 
Time-out, the software appears to add 30 minutes to any user-specified time. So, if 45 seconds is entered for the pre-
measurement delay and the SOP is saved, the value appears to be shifted to 30min 45 sec when the SOP is opened for 
review. 

It is only the display of some time-based parameters in SOP dialogues which is affected by the above bug, rather than the 
application of these parameters during an SOP-based measurement. For example, if 45 seconds is specified by a user for 
the pre-measurement delay, this will be correctly applied during an SOP measurement even though 30min 45 sec is 
displayed in the relevant SOP dialogue. In addition, the correct value for the pre-measurement delay (or any other time-
based parameter) is stored in the measurement record and would be correctly printed on any reports referencing this value. 
Users can therefore validate that the correct time has been applied post-measurement.  

 

Firmware change for the Hydro 2000S and Hydro 2000G accessories 
The electronics and firmware used in the Hydro 2000S and Hydro 2000G accessories has been updated in order to improve 
the supportability of these systems in the long term. This has caused an update to the accessory calibration procedures, 
which are typically carried out during an Operational Qualification. To support the new calibration methods, the following 
software macros have been developed: 

• Hydro G Pump + Stir Cal.BAS 
• Hydro S Stirrer Cal.BAS 

 

These macros are compatible with v5.30 and above of the Mastersizer 2000 software. For customers using versions prior to 
v5.30, any change to the calibration values will need to be carried out using a computer running v5.30 or above (e.g. using a 
service engineer’s laptop).  
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